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«Scegliere un dipinto di un museo e analizzarlo in RGB (red, green, blue), i tre colori che compongono
l'immagine televisiva per intenderci. Poi creare un istogramma tridimensionale per ogni componente,
quindi con i valori esportati creare con una stampante 3D tre piccole tavolette di 10 o 12 pollici che
rechino in sovraimpressione tipo braille la quantità di colore/luce presente nel dipinto, ovviamente
diversa per ogni colore preso in esame. Il cieco, passando le dita sulle tavolette, dovrebbe avere una
percezione della presenza e diffusione di ognuno dei tre colori. Le tavolette potrebbero essere utilizzate
anche dai vedenti in camera buia con un'esperienza tipo “cena al buio”.» 1

Il Prof. Andrea Chiariello, Ricercatore in Elettrotecnica presso la Seconda Università di
Napoli, dietro richiesta del Prof. Stefano Colonna nel gruppo aperto Facebook di Architettura
Liquida espressa in data 27/11/2018 ha cortesemente fornito nello stesso gruppo in data
28/11/2018 2 il codice GNU Octave 3 per l’analisi numerica con cui Stefano Colonna (con una
piccola modifica non pubblicata 4 ) ha realizzato la scomposizione RGB del Sogno del
Cavaliere, dipinto ad olio su tavola di Raffaello Sanzio, databile 1503-1504 presentata al
pubblico in data 29 novembre 2016.

Con questo approccio matematico il Prof. Stefano Colonna, insieme ad Andrea Chiariello,
sono giunti alla generazione di tre immagini distinte, ognuna delle quali rappresenta un
cromatismo specifico.

La metodologia ivi proposta dal Dr. Guglielmo Maria Gioele Chiavistelli per l’ottenimento
delle Tavolette Cromatiche 3D RGB pseudo-braille prevede una scomposizione RGB che
raggiunge il medesimo risultato, procedendo però all’inverso: da un criterio grafico-visivo si
ottiene un risultato matematico-scientifico.

L’input visivo, infatti, tradotto in informazione binaria dall’elaboratore, viene processato
mediante specifici algoritmi all’interno di software professionali che sono in grado di
trasferirlo, sotto forma di rilievo, ad un oggetto tridimensionale.

I pixel, gli elementi grafici minimi che costituiscono l’immagine digitale, vengono perciò
trasformati in una sorta di “istogramma tridimensionale” che fornisce le informazioni chiave
per la generazione del modello 3D. Ecco dunque spiegata quest’inversione di rotta: si voleva
partire dalla “materia digitale”, volatile, impalpabile, per approdare a quella reale, tangibile.

In seguito ad una ricerca iconografica filtrata “per dimensioni” con il motore di ricerca Google
(http://www.google.it), è stata rintracciata l’immagine digitale con la risoluzione ottimale (per
ragioni che saranno evidenti) raffigurante il Sogno del Cavaliere.

Fig. 1
 Sogno del Cavaliere,

immagine digitale,
metodo: Colore RGB (8
Bits/Channel),
risoluzione 1040x1024
pixel.

Fig. 2
 Le informazioni sul

metodo e sulla
profondità colore
vengono fornite dal
software Adobe
Photoshop.

Fig. 3
 Un’immagine ad 8-Bit

può riprodurre fino a
16,8 milioni di colori,
derivanti dalla
mescolanza dei colori
primari e dalle 256
tonalità per ogni singolo
canale.
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La scelta è ricaduta sull’immagine “bta02892.jpg” presente sul sito del BTA - Bollettino
Telematico dell’Arte (1040x1024 pixel) 5 [FIGURA 01].

Aprendo l’immagine con il software Adobe Photoshop, si è verificato il metodo colore della
stessa dal pannello richiamabile mediante il menu Immagine > Metodo.

Il metodo colore determina il numero dei canali di colore dell’immagine stessa.

Le specifiche dell’immagine processata sono le seguenti: formato JPEG, occupazione di
spazio su disco di 276 KB e metodo Colore RGB[FIGURA 02].

La corrispondenza al metodo colore RGB presuppone il fatto che l’immagine contenga un
canale per ogni colore principale che la compone (uno per il rosso, uno per il verde ed uno per
il blu), oltre ad un altro canale composito che rappresenta l’immagine come la si vede nella sua
integrità, con i tre i canali congiunti; generalmente quest’ultimo viene utilizzato per effettuare
modifiche sulla totalità dell’immagine, piuttosto che su di un singolo canale. Nel caso del
metodo RGB, i canali sono immagini in scala di grigio all’interno delle quali sono contenute le
informazioni relative alla quantità dei tre colori primari della luce (Red, Green e Blue)
necessarie per formare tutti gli altri colori che costituiscono l’immagine; le informazioni
numeriche sui “dosaggi” presenti in ciascuno dei tre canali, infatti, sommandosi le une alle
altre, restituiscono l’immagine di partenza nella sua integrità cromatica 6 .

Un’altra indicazione che si ricava richiamando il pannello del metodo dell’immagine è relativa
alla profondità colore, in questo caso 8 Bit/Canale. Quest’ultima informazione è desumibile
anche partendo dalla sola estensione del file. Il formato JPEG infatti, essendo un formato
compresso, contempla soltanto una profondità colore di 8 bit.

Ogni singola sfumatura di colore presente in un’immagine digitale RGB scaturisce dunque
dalla combinazione dei tre colori/canali primari: rosso, verde e blu; la molteplicità dei colori
possibili è offerta dalle variazioni di tonalità, saturazione e luminosità.

Disporre di una profondità colore di 8 bit per ogni canale significa che esistono 256 tonalità di
rosso, 256 di verde e 256 di blu che, moltiplicate fra loro, producono fino ad un massimo di
16,8 milioni di colori. Il numero 256 scaturisce dal sistema binario che sta alla base
dell’informatica, per cui un bit (binary digit), che può esprimere al massimo 2 valori (“0”
oppure “1”), viene elevato all’ottava potenza (28 = 2 x 2 x 2 x 2 x 2 x 2 x 2 x 2 = 256) 7
[FIGURA 03] .

La differenza sostanziale nel numero di bit (8, 16 o 32) che identifica la profondità colore di
un’immagine, sta nella quantità di informazioni relative ai colori che sono alla base della
composizione della stessa. Maggiore è la profondità colore, maggiori sono le informazioni che
l’immagine porta con sé per ogni singolo canale di colore, maggiore, di conseguenza, è anche
la possibilità che l’immagine digitale immagazzini una quantità di dati tale da poter essere
definita cromaticamente più o meno “fedele” all’opera originale.

Si è volutamente fatto ricorso alle virgolette in quanto, ovviamente, la riproduzione digitale di
una qualsiasi opera d’arte non potrà mai essere neppure lontanamente fedele all’originale; sono
infatti molti i fattori che influenzano il processo di digitalizzazione di un’opera d’arte.

Un esempio su tutti è offerto dal cosiddetto “bilanciamento del bianco” che influenza la
temperatura del colore, modificando, di fatto, sostanzialmente la percezione cromatica
dell’opera mediata dalle strumentazioni digitali rispetto all’osservazione dal vivo della stessa
[FIGURA 04].

Ci si potrebbe interrogare sulla natura stessa della percezione del colore e chiedersi se davvero
sia legittimo ricercare una corrispondenza esatta tra una tonalità presente all’interno di un
range (seppure molto grande) offerto da una gamma di colori sintetici digitali ed una porzione
di tela o di affresco (seppure molto piccola), così come si potrebbero studiare
approfonditamente le possibilità da parte di un software nel riproporre, più o meno
attendibilmente, i cromatismi differenti che possono risiedere all’interno di una singola
pennellata; quest’ultima, il più delle volte, reca al suo interno minuscoli grumi di colore scelti
in precedenza dall’artista, molteplici tonalità che, rimaste intrappolate tra le setole del
pennello, si sono sprigionate sul supporto materico che costituisce l’opera, originando un
colore nuovo.

Queste sollecitazioni sulla percezione del colore e sul rapporto tra opera riprodotta
digitalmente ed originale sono certamente da rimandare ad altre sedi più adatte e non rientrano
direttamente in questo ambito. Vi si è comunque ricorso in quanto alla base di questo metodo,
volto alla produzione delle tavolette pseudo-braille RGB, risiede una delle tante possibili
riproduzioni informatiche di un’opera d’arte, con tutte le limitazioni del caso, alcune già

Fig. 4
 Due immagini digitali

trovate in rete
riproducono lo stesso
affresco di Michelangelo
Buonarroti, Creazione
di Adamo, databile 1511
circa. Le immagini sono
state ritagliate ed
accostate per favorire il
confronto. Impossibile
dire quale sia la più
“fedele” all’affresco
originale; infatti, a
seconda della
temperatura del colore
impostata nella
macchina fotografica
digitale e ad altre
variabili, come ad
esempio l’orario in cui è
stata scattata la
fotografia, le tonalità
mutano radicalmente. In
questo caso, inoltre,
l’immagine in basso è
lievemente sfocata e
meno definita rispetto a
quella in alto che
presenta anche
contrasto e risoluzione
maggiori.

Fig. 5
 Nella porzione superiore

è stato isolato un
dettaglio che
corrisponde ad un
ingrandimento del 120%
rispetto all’immagine
originale. Nella
porzione inferiore,
invece, lo zoom digitale
è del 500%. La
differenza nella
definizione della
porzione di sinistra
rispetto a quella di
destra è evidente. I
dettagli a sinistra sono
stati prelevati
dall’immagine di
partenza che, come
precedentemente
accennato, possiede una
risoluzione di
1040x1024 pixel, quelli
sulla destra sono estratti
dalla stessa immagine
con risoluzione di
347x341 pixel (pari ad
un terzo dell’immagine
originale).
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accennate, dovute ad esempio al medium digitale impiegato, piuttosto che alla risoluzione
dell’immagine di partenza. Per concludere il quadro sommario fin qui delineato sull’immagine
digitale, dal quale questa indagine prende le mosse, e per terminare un’introduzione pensata
per fornire alcune informazioni basilari con l’intento di semplificare la comprensione della
tematica in oggetto, occorre soffermarsi brevemente anche sul concetto di risoluzione
[FIGURA 05].

L’immagine digitale, com’è noto, è fatta di pixel, le cellule dell’immagine, migliaia di elementi
puntiformi che la delineano 8 . Maggiore è il numero dei pixel, «l’unità minima gestibile dal
computer sul monitor» 9 , più è alta la quantità di informazioni disponibili.

Un’immagine con una risoluzione alta risulta ben definita e dettagliata, ciò significa che la
qualità dell’immagine varia proporzionalmente rispetto alla quantità di pixel che la
compongono. Un’elevata quantità di pixel presuppone il fatto che essi siano più piccoli e
concentrati e quindi meno visibili ad occhio nudo. Una risoluzione migliore riduce anche la
presenza di alcuni difetti propri dell’immagine digitale, quali pixellizzazione e noising, di cui si
parlerà più avanti.

Tornando al procedimento realizzativo delle tavolette pseudo-braille RGB, occorre riferire che
è stato scelto un approccio scientifico che prevede anche il coinvolgimento da parte di un
operatore. Il metodo che sarà illustrato non può infatti considerarsi totalmente indipendente
dall’utente che lo porta a compimento. Egli si avvale di software professionali con algoritmi
molto potenti in grado di restituire informazioni complesse con la precisione e l’affidabilità
proprie del calcolatore informatico, e, allo stesso tempo, partecipa al processo creativo in
prima persona lasciando, in ogni caso, una traccia del suo operato sul prodotto finale. Egli,
come si vedrà, perfeziona, riduce gli artefatti ed aggiusta le forme, smussandole e rendendole il
più possibile omogenee, per offrire una loro migliore percezione al tatto, cercando sempre di
garantire la corretta corrispondenza cromatica tra i rilievi prodotti ed i canali RGB dell’opera
originale. L’operatore lavora cercando di raggiungere il miglior compromesso tra qualità,
realizzabilità e fruibilità del prodotto finale. Egli deve limitare al minimo il suo intervento,
esclusivamente laddove necessario, motivando sempre le sue azioni ogni qual volta si trovi
costretto ad agire, specificando le modalità in cui impostazioni e parametri dei software
utilizzati vengono modificati per il raggiungimento di determinati risultati.

L’idea alla base per la realizzazione di questo progetto deriva dall’esperienza dell’autore nel
campo della computergrafica, in particolare dalla conoscenza di software CAD 10 , quali
Autodesk Maya, che consentono all’utente di modellare oggetti tridimensionali all’interno di
uno spazio interattivo (la viewport) e di seguire in tempo reale gli sviluppi dell’intero processo
creativo di progettazione, modellazione, illuminazione e resa finale.

In particolare si è cercato di trasferire la logica che è alla base delle bump maps (mappe di
rilievo) utilizzate all’interno dei software sopra citati per creare una sorta di bassorilievo
tridimensionale a partire da un’immagine.

Una bump map crea una sensazione di profondità sulla superficie di un modello
tridimensionale; non aggiunge ulteriore risoluzione ad esso, ma è in grado di trasmettere
l’illusione del rilievo servendosi di un semplice trucco di illuminazione.

Le mappe di rilievo consentono di realizzare velocemente alcuni dettagli senza dover
necessariamente ricorrere ai procedimenti propri della scultura digitale. Queste mappe sono
particolarmente indicate per la creazione di dettagli molto piccoli sui modelli 3D (ad esempio
pori o rughe della pelle). Generalmente le mappe di rilievo sono immagini grayscale (con
metodo di colore Scala di grigio) con una profondità colore limitata ad 8 bit. In riferimento a
quanto affermato in precedenza, si tratta di immagini che possono contare su un singolo canale
e, di conseguenza, su un massimo di 256 differenti tonalità, in questo caso limitate
esclusivamente ai colori nero, grigio e bianco. Questi valori tonali in una mappa di rilievo
vengono impiegati per comunicare al software 3D due input fondamentali ed opposti: alto o
basso.[FIGURA 06]

Quando i valori cromatici di una bump map si avvicinano al grigio, i dettagli che emergono
sulla superficie sono minimi o inesistenti, se invece virano verso il bianco essi sembrano uscire
fuori dalla superficie, mentre, se si fanno più scuri, avvicinandosi al nero, l’effetto ottico è
quello dello sprofondamento della superficie, come se quest’ultima venisse spinta verso il
basso 11 . Queste mappe sono relativamente semplici da creare e modificare all’interno di un
software di grafica 2D come ad esempio Adobe Photoshop.

Si è pensato di ricercare una soluzione simile a quella delle bump maps per trasferire su un
oggetto tridimensionale un determinato dettaglio partendo da un’immagine in scala di grigi.
Per cominciare è stato perciò necessario scomporre l’immagine digitale di partenza nei tre
singoli canali RGB. Per tale scopo si è utilizzato ancora una volta Photoshop, che si è rivelato

Fig. 6
 In primo piano una sfera

di mattoni creata con il
software Autodesk
Maya. La forma è stata
divisa in due parti per
rendere più evidente
l’effetto ottenuto
ricorrendo alle mappe di
rilievo. La metà
superiore è rivestita
esclusivamente con la
mappa del colore,
mentre a quella
inferiore, che presenta
un maggior dettaglio ed
evidenzia le porosità e le
asperità di ogni singolo
mattoncino, è stata
aggiunta una bump map.
Sul fondo sono state
messe a confronto le due
mappe, a sinistra la
semplice mappa del
colore, a destra la
mappa di rilievo
realizzata con il
software Adobe
Photoshop, ottenuta
duplicando la prima,
trasformandola in scala
di grigio, virandola al
negativo e modificando i
livelli di chiaro/scuro.

Fig. 7
 La scheda Canali

presente all’interno del
software Adobe
Photoshop.

Fig. 8
 Opzioni utilizzate per il

salvataggio dei singoli
file in Scala di grigio in
formato TIFF.
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lo strumento più funzionale per l’operazione; infatti, nella scheda dedicata ai Canali del
programma sono già presenti le immagini in scala di grigio relative ai tre singoli canali RGB
12 . [FIGURA 07]

Ogni canale è stato isolato e salvato separatamente. Le tre nuove immagini così ricavate sono
state archiviate in formato TIFF non compresso; ciascuna occupa uno spazio su disco di 5,5
MB ed ha un metodo colore Scala di grigio e 8 Bit/Canale di profondità colore. [FIGURA 08]
[FIGURA 09]

In ciascuna delle immagini ottenute, le tonalità di bianco, grigio e nero rappresentano le
quantità di ognuno dei tre colori RGB che costituiscono l’immagine globale.

Ciascuna delle immagini in scala di grigio agisce come una sorta di “filtro” che lascia passare
quantità diverse di luce/colore, che poi, addizionandosi alle altre, genera l’intera gamma delle
variazioni cromatiche presenti nell’immagine 13 . I valori cromatici dei file in grayscale vanno
letti in questo modo: le aree più chiare sono quelle in cui il colore rappresentato è
maggiormente presente, al contrario, più ci si sposta verso il nero e minore è la quantità di
colore impiegato. Le zone grigie, che solitamente sono presenti in percentuale maggiore
rispetto a quelle bianche e nere, lasciano filtrare più o meno colore in base ai livelli di
chiaro/scuro della loro gradazione di grigio. Per semplificare si parla di aree e di zone, ma
occorre tener presente che l’operazione avviene per ogni singolo pixel che compone
l’immagine. A questo punto dovrebbe risultare ancor più chiaro quanto già accennato
nell’introduzione: disponendo di una risoluzione alta e, quindi, di una quantità maggiore di
pixel, sarà di conseguenza più precisa e completa anche la corrispondenza dei colori.

Al pari delle mappe di rilievo, le tre immagini in scala di grigio vengono utilizzate come una
sorta di “calco”, fungendo da istogrammi per la creazione dei bassorilievi.

Nel caso delle tavolette pseudo-braille RGB, però, non è sufficiente fornire una parvenza di
rilievo, ma quest’ultimo deve risultare realmente impresso, memorizzato su un oggetto
tridimensionale per essere poi affidato ad una stampante 3D e materialmente prodotto.

Sono state perciò indagate le modalità per la creazione di un bassorilievo tridimensionale a
partire da un’immagine. È stata cercata una soluzione che fosse precisa e che, allo stesso
tempo, restituisse un buon risultato senza dover ricorrere ad eccessivi interventi da parte
dell’utente, garantendo un approccio più scientifico e rigoroso possibile.

In questa fase della Ricerca sono stati consultati molti siti internet e forum; tra i portali più
interessanti si ricorda in particolare 3DRivilevi.it 14 , al cui interno si trovano numerosi
consigli che derivano dall’esperienza diretta di centinaia di utenti; essi condividono
quotidianamente sul sito le loro creazioni digitali e mantengono vivo il dibattito su quali siano
le migliori soluzioni creative. Altrettanto imprescindibili per lo studio del software individuato
e scelto per la realizzazione delle tavolette pseudo-braille, si sono rivelati i video
dell’inventore australiano Roger Clyde Webb presenti sul suo canale YouTube 15 .

Autodesk ArtCAM fa parte della categoria dei software CAD/CAM 16 sviluppati per consentire
agli ingegneri di progettare e produrre prodotti. Nello specifico questo programma è noto
perché accosta all’approccio artistico quello prettamente tecnico-matematico, tanto da renderlo
uno degli strumenti più utilizzati da designer ed artisti per creare praticamente qualsiasi cosa
possano immaginare. «ArtCAM è impiegato in una varietà di settori, dalla coniatura di gioielli
e monete, alla progettazione e produzione di cornici architettoniche e facciate. Il tema comune
in tutti questi settori è il desiderio di produrre forme artistiche intricate con dettagli incredibili
che possono essere facilmente lavorati o stampati in 3D.» 17 .

ArtCAM è un software complesso che consente moltissime operazioni per la creazione e la
gestione di rilievi, nonché per la loro stampa in 3D, che può essere impostata e gestita anche
restando all’interno dello stesso programma. In questo frangente ci si servirà esclusivamente di
alcune funzioni basilari che consentono, come ci si è prefissato, di realizzare in pochi passaggi
un rilievo a partire da un’immagine per poi ottimizzarlo.

Prima di utilizzare il software in questione, però, ci si è serviti ancora una volta di Photoshop
per aggiungere alle tre immagini in scala di grigio create in precedenza una piccola cornice di
colore nero, in modo che intorno al bassorilievo si generi una minima bordatura. La scelta del
colore nero è data dal fatto che si vuole che il bordo resti sul fondo rispetto al rilievo. Per
creare la cornice è stato eseguito il comando Immagine > Dimensione quadro… > Nuova
dimensione; il quadro dell’immagine è stato espanso. Impostando quindi Livello > Nuovo… >
Livello è stato creato un layer, spostato sul fondo e quindi riempito di colore nero mediante il
menu Modifica > Riempi… > Contenuto: Nero.

Fig. 9
 Immagini grayscale

ottenute isolando i
singoli canali RGB e
salvandoli in tre file
separati: rosso, verde e
blu.

Fig. 10
 ArtCAM consente la

creazione di un modello
tridimensionale a
partire da un’immagine.

Fig. 11
 Vengono impostate le

dimensioni del progetto
e l’altezza massima del
rilevo.

Fig. 12
 In alto: rilievo iniziale

grezzo ottenuto in
ArtCAM, vista frontale.
In basso: dettaglio, vista
prospettica.

Fig. 13
 Strumento Rilievo
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Seguendo questo procedimento si evita una perdita di risoluzione e non si modificano le
proporzioni dell’immagine di partenza, garantendone anche la perfetta quadratura.

La risoluzione di ogni singola immagine in scala di grigio generata in precedenza è passata
dunque dai 1040x1024 pixel originari ai 1077x1077 pixel; in questo modo si rispettano anche
proporzioni e dimensioni dell’opera originale di Raffaello (17x17 cm) che si è scelto di
mantenere inalterate anche per le tavolette pseudo-braille RGB stampate in 3D.

Finalmente si è passati all’impiego del software Autodesk ArtCAM.

Una volta caricato il programma è stato impartito il comando File > Nuovo > Modello da
immagine.

ArtCAM invita quindi l’utente a caricare l’immagine dalla quale partire per la generazione del
rilievo. Per cominciare è stata selezionata l’immagine in scala di grigio che rappresenta
l’incidenza del colore rosso. [FIGURA 10]

Dopo aver scelto l’immagine, si apre una nuova finestra in cui il software chiede all’utente di
impostare le dimensioni del progetto. Definita l’unità di misura con la quale lavorare
(millimetri anziché pollici), si è optato per un’altezza ed una larghezza di 170 mm (per
rispettare appunto le misure dell’opera originale) ed un’altezza dell’asse Z di 1,3 mm.
Quest’ultimo parametro è fondamentale in quanto permette di impostare fin da subito l’altezza
massima che si desidera conferire al rilievo. In questo caso, dovendo creare delle tavolette
pseudo-braille, è stata presa una decisione in linea con gli standard delle mappe tattili braille,
che contemplano un’altezza del rilievo da un minimo di 0.9 mm ad un massimo di 1,3 mm 18 .
[FIGURA 11]

In pochi secondi il software è in grado di generare un primo rilievo in base ai parametri
inseriti, anche se il risultato iniziale è piuttosto grezzo; l’algoritmo preposto alla creazione del
rilievo a partire da un’immagine funziona bene e l’immagine in scala di grigio consente al
programma di tradurre in bassorilievo le informazioni relative, in questo caso, al canale rosso,
in relazione alle variazioni di chiaro/scuro di ogni singolo pixel, proprio come previsto. Le
differenze tra le altezze del bassorilievo, però, risultano eccessivamente nette e per nulla
omogenee tra loro, generando una granulosità eccessiva. [FIGURA 12]

Per correggere il difetto esiste lo strumento Rilievo uniforme, selezionabile dall’apposito
pulsante della barra dei menu, oppure attraverso l'opzione del menu Rilievo > Modifica >
Uniforme. Questo tool «consente di uniformare le irregolarità della superficie su un livello
rilievo in tempo reale.» 19 . Successivamente si apre una nuova finestra in cui è possibile
scegliere l’area del rilievo da uniformare. Si può agire sull’intero livello, selezionare un vettore
all’interno del quale svolgere l’operazione, oppure uniformare un’area della superficie definita
da un colore. In questo caso, essendo necessario operare sulla totalità del rilievo, è stata
selezionata l’opzione Intero Livello. Per quanto riguarda le passate dell’ammorbidimento è
stato lasciato invariato il valore “1” di default per avere sotto controllo i singoli passaggi.
[FIGURA 13]

Subito dopo il primo passaggio di ammorbidimento i miglioramenti sono evidenti, anche
questo algoritmo svolge con precisione il proprio dovere. Malgrado la situazione sia migliorata
sensibilmente, si evincono ancora alcuni difetti, dovuti più che altro a disturbi e imperfezioni
dell’immagine digitale di partenza, come ad esempio la pixellizzazione ed il noising, già citati
nell’introduzione. Il disturbo arrecato all’immagine è simile.

Nello specifico: la pixellizzazione è «[…] una sgranatura più o meno pronunciata nei contorni
delle figure» , mentre il noising (o rumore video) «[…] è un’errata informazione
dell’immagine che si presenta sotto forma di sgranatura o sfrigolio. A differenza della
pixellizzazione può estendersi ad intere porzioni (dell’immagine, ndr) […]» 21 . Questo difetto
può essere «[…] provocato da una forte compressione dei dati […]» 22 . [FIGURA 14]

Vista la finalità della Ricerca, ovvero la stampa 3D delle tavolette pseudo-braille che verranno
testate da alcuni soggetti portatori di handicap e non, l’aspetto tattile risulta sostanziale;
sarebbe stato impossibile fermarsi qui, lasciando evidenti difetti sul modello. È stato quindi
eseguito un altro passaggio con lo strumento Rilievo uniforme.

A questo punto il difetto è stato attenuato almeno dell’80%; si è provato comunque ad
effettuare un ulteriore passaggio di ammorbidimento, ma i contorni delle figure stavano
cominciando a modificarsi, abbassandosi eccessivamente ed alcuni dettagli importanti
cominciavano a scomparire. Il comando è stato quindi annullato e ci si è fermati a tre passaggi
con lo strumento Rilievo uniforme. [FIGURA 15] [FIGURA 16]

uniforme e relative
impostazioni.

Fig. 14
 Viene proposto un

confronto tra un
dettaglio dell’immagine
originale ingrandito del
420% ed il suo
corrispettivo nel rilievo
relativo al canale rosso
appena ottenuto, reso
più omogeneo dopo un
passaggio del tool
Rilievo uniforme. Una
porzione di cielo è stata
ulteriormente ingrandita
per rendere ancor più
chiara la
corrispondenza tra i
difetti dell’immagine
digitale e quelli
riscontrati sul rilievo.
Sono stati evidenziati i
disturbi di
pixellizzazione e noising
che affliggono sia
l’immagine originale sia
il bassorilievo.

Fig. 15
 La tavoletta è stata

divisa in tre porzioni,
dall’alto verso il basso,
una per ogni passaggio
eseguito con il tool
Rilievo uniforme. Vi è
una progressiva
riduzione dei disturbi
inizialmente riscontrati.

Fig. 16
 Dall’alto verso il basso:

alcuni dettagli mostrano
i miglioramenti
gradualmente ottenuti
sul bassorilievo.
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Come già affermato, il presente metodo, per quanto automatizzato e dipendente dagli algoritmi
di ArtCAM, prevede comunque la mediazione da parte di un operatore, soprattutto in questa
fase, forse la più delicata, in cui occorre stabilire il momento in cui il livello di dettaglio
raggiunto dal bassorilievo corrisponde alle esigenze del ricercatore.

Bisogna sapere a che punto arrestare i miglioramenti, prima che questi ultimi si tramutino in
peggioramenti, modificando eccessivamente le forme e compromettendo, di fatto, l’intera
operazione che ci si è prefissata: raggiungere una corrispondenza attendibile, per ogni colore
preso in esame, tra quantità di colore/luce presente nel dipinto e rilievo.

È per questo che si è scelto di ridurre al minimo l’intervento dell’utente, ricorrendo soltanto a
strumenti controllati dagli algoritmi dell’elaboratore, piuttosto che adoperarne degli altri che,
seppure molto efficaci, avrebbero potuto contravvenire ai princìpi della Ricerca, implicando
componenti spiccatamente soggettive tra cui, ad esempio, la manualità dell’operatore.

A questo punto è stato necessario creare a tutti gli effetti il modello tridimensionale (detto
anche mesh). Le operazioni svolte fin qui, infatti, sono solo anteprime del risultato finale,
passaggi che da soli non generano alcun modello 3D.

Quest’ultimo viene creato con lo strumento Crea Mesh di Triangoli, selezionabile
dall’apposito pulsante nella barra dei menu, oppure attraverso l’opzione del menu Rilievo >
Esporta > Crea Mesh di Triangoli.

Si ricorre a questo tool per realizzare l’oggetto tridimensionale destinato alla stampa 3D;
quest’ultimo «[…] è composto da una serie di sfaccettature triangolari che rappresentano una
forma 3D chiusa. Ogni sfaccettatura è caratterizzata dalle coordinate X,Y,Z e da un
orientamento.» 23 .

Il fatto che la mesh sia chiusa è fondamentale, in caso contrario non sarebbe possibile
stamparla in 3D. Selezionato lo strumento, una nuova scheda compare sullo schermo.

Per questioni di praticità, non vengono prese in considerazione tutte le opzioni disponibili per
la creazione e l’esportazione di modelli 3D in ArtCAM, ma soltanto quelle utilizzate in questo
frangente.

Per renderle più resistenti, si è scelto di dare alle tavolette uno spessore aggiuntivo che non
inficia con quello del rilievo, a sé stante. Al fine di aggiungere la profondità desiderata è stata
selezionata l’opzione Chiudi con offset ed il campo Spessore è stato riempito con la misura di
5 mm. Quando si clicca sul pulsante Crea, il programma comincia a calcolare la geometria
dell’oggetto; al termine del processo, si forma il 3D effettivo che prende il posto
dell’anteprima con la quale si è lavorato fino a quel momento. Compaiono anche altre
informazioni sull’oggetto appena realizzato, ma, soprattutto, nella nuova sezione Esporta
appare il pulsante Salva. Cliccando su quest’ultimo si ha la possibilità di memorizzare
l’oggetto 3D in un file. Tra i formati a disposizione ci sono STL ed OBJ, entrambi accettati
dalle stampanti 3D, anche se il primo è nato esclusivamente per questa destinazione. [FIGURA
17]

La tavoletta è stata dunque salvata in formato STL; il file occupa uno spazio su disco di 78,4
MB. Purtroppo la faccia sottostante presenta delle irregolarità che sono emerse ad ogni
tentativo di superare il problema, tanto da far pensare ad un bug del programma.

Per sistemare la mesh si è deciso di aprire il file appena creato con Autodesk Maya e di
rimpiazzare il fondale difettato con uno nuovo. Sono state cancellate le facce compromesse e
ricreato il retro mediante l’estrusione interna del perimetro rimasto forato. Il file corretto è
stato esportato momentaneamente in formato OBJ vista l’impossibilità di salvare in STL.
[FIGURA 18] [FIGURA 19]

Si giunge dunque all’ultimo passaggio prima della stampa 3D: l’ottimizzazione e la pulizia del
modello. Con questo obiettivo ci si è serviti del software MeshLab.

Caricato il programma ed aperto il file esportato da Maya, in basso compare subito
un’informazione interessante, relativa al numero dei vertici e delle facce del modello.
[FIGURA 20]

Si procede al controllo e all’eventuale riparazione dei difetti della forma. Tutti gli strumenti
che servono in questa fase sono richiamabili attraverso il menu Filters > Cleaning and
Repairing. Vi sono molte operazioni possibili per pulire e riparare la mesh. Alcune delle
principali sono: Remove Duplicate Faces, Remove Duplicate Vertices, Remove Faces from
Non-Manifold Edges, Remove Isolated Folded Faces by Edge Flip, Remove Unreferenced
Vertices, Remove Zero Area Faces. Non è necessario spiegare lo scopo di ognuno di questi

Fig. 17
 Vengono impostati i

valori per la creazione
dell’oggetto
tridimensionale che
successivamente viene
salvato.

Fig. 18
 Il retro della tavoletta

difettato viene
rimpiazzato da un nuovo
fondale all’interno del
software Autodesk
Maya.

Fig. 19
 Dettaglio dei triangoli

che compongono la
geometria del rilievo
sulla tavoletta pseudo-
braille.

Fig. 20
 Il software MeshLab che

serve principalmente per
controllare che non vi
siano difetti nel modello
prima di mandarlo in
stampa, mostra anche il
numero dei vertici e
delle facce della mesh.
In questo caso, la
tavoletta pseudo-braille
relativa al canale rosso
è composta da 251.916
vertici e 503.832 facce.

Fig. 21
 Prototipo della Prima

Tavoletta 3D RGB,
canale RED, rosso,
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comandi, ciò che conta è capire che essi controllano diversi aspetti della geometria e la
riparano laddove necessario; si va dalla rimozione di facce o vertici in eccesso a quella di facce
che non seguono la geometria che vi è in natura (e perciò vanno corrette perché altrimenti
restituirebbero errori in fase di stampa) e così via. Sono stati eseguiti tutti questi controlli e
ciascuno di essi ha restituito esito negativo, ad eccezione di Remove Faces from Non-Manifold
Edges che ha evidenziato la presenza di quattro facce con geometria errata che sono state
automaticamente corrette dal programma, così come segnalato all’interno del report delle
attività che appare in una finestra in basso a destra. Il modello tridimensionale è stato quindi
esportato in formato STL mediante il menu File > Export Mesh As…. L’intero procedimento
sinora esplicato è stato ripetuto per le altre due tavolette, per i canali verde e blu. I tre modelli
sono finalmente pronti per essere stampati in 3D.

A questo è stato necessario affidarsi ai professionisti di Aspramente Studio Srls., fondatori di
3DiTALY 24 , il primo 3D Printing Store ad operare in Italia, «progetto indipendente di
laboratorio pionieristico e sperimentale» 25 che offre molteplici servizi per la stampa 3D.

Si ringrazia in particolare il Sig. Carlo Mariella per aver offerto il suo personale supporto, oltre
che competenza tecnica, alla presente Ricerca.

Si è scelto di stampare in 3D il prototipo della tavoletta cromatica pseudo-braille che
rappresenta la presenza del canale rosso nell’opera.

Il materiale impiegato, denominato PLA, è il più diffuso per la prototipazione rapida, oltre ad
essere ecocompatibile e totalmente compostabile una volta utilizzato, derivando da piante
come mais, grano o barbabietola. La stampante, una ULTIMAKER 3 26 , si serve di una
tecnologia FDM (modellazione ad estrusione fusa).

La corrispondenza tra modello generato in computergrafica e stampa 3D è risultata
soddisfacente, ma, dal momento che sono state riscontrate alcune lievi imperfezioni al tatto, si
è deciso di procedere stampando lo stesso oggetto con materiale e tecnologia superiori.

A tale scopo si è ricorso ad una FORM 2, stampante che, sfruttando la tecnologia SLA
(stereolitografia) è in grado, grazie all’impiego di una luce laser, di solidificare la resina
liquida in strati finissimi. La tecnologia SLA rappresenta, al momento, la massima espressione
della stampa 3D, con una qualità paragonabile a quella delle stampanti industriali 27 . Il
risultato è sembrato ancor più fedele al modello tridimensionale creato al computer, piacevole
al tatto e perfettamente liscio nelle zone piane.

Un ulteriore differenza rispetto al prototipo in materiale PLA è riscontrabile nelle dimensioni
dell’oggetto stampato. La stampante FORM 2, infatti, arriva ad un massimo di superficie
stampabile di 14,5 cm x 14,5 cm. È stato dunque necessario ridurre leggermente le dimensioni
della tavoletta per stamparla in resina. Inoltre, mentre il prototipo è stato stampato con un
filamento di colore rosso, così da garantire ai vedenti una corrispondenza immediata tra
tavoletta e bassorilievo corrispondente, la tavoletta in resina è stata stampata in grigio, dal
momento che questo tipo di materiale attualmente non prevede i colori.

Questi primi risultati sono stati presentati in anteprima agli studenti il giorno 7 marzo 2018
durante l’Insegnamento di Museologia e Critica Artistica e del Restauro del Prof. Stefano
Colonna. Gli studenti, ai quali è stata offerta un’esperienza tattile, hanno avuto modo di
verificare in prima persona come dalla prototipazione si sia arrivati ad un oggetto levigato,
liscio e iper-dettagliato, requisito indispensabile della presente Ricerca, dal momento che le
tavolette dovranno essere sottoposte a soggetti non vedenti. [FIGURA 21] [FIGURA 22]
[FIGURA 23][FIGURA 24] [FIGURA 25] [FIGURA 26]
 

CONCLUSIONI E POSSIBILI SVILUPPI DELLA RICERCA

I risultati raggiunti partendo da una riproduzione digitale di un’opera d’arte, un’immagine
compressa in formato JPEG, con una profondità colore di 8 bit per canale e con una
risoluzione accettabile, ma decisamente non elevata, sono comunque soddisfacenti e lasciano
aperte ulteriori sperimentazioni e migliorie nel campo della realizzazione in 3D delle tavolette
pseudo-braille RGB.

Data la natura sistematica alla base del metodo esposto, strettamente legata alla qualità
dell’immagine digitale presa come modello per effettuare i rilievi, si può facilmente desumere
che, partendo da un file ad una risoluzione molto elevata e garantendo dunque una quantità di
pixel più alta rispetto a quella a disposizione in questo caso, anche il rilievo ne risulterebbe
ottimizzato. Verrebbe anche ridotta in modo significativo la presenza degli artefatti
dell’immagine digitale e, di conseguenza, la necessità degli interventi migliorativi da parte
dell’operatore.

Tavoletta con errori di
stampa in PLA.

Fig. 22
 Prototipo della Prima

Tavoletta 3D RGB,
canale RED, rosso,
DETTAGLIO Tavoletta
con errori di stampa in
PLA.

Fig. 23
 Prototipo della Prima

Tavoletta 3D RGB,
canale RED, rosso,
Tavoletta senza errori di
stampa in PLA.

Fig. 24
 Prototipo della Prima

Tavoletta 3D RGB,
canale RED, rosso,
DETTAGLIO Tavoletta
senza errori di stampa
in PLA.

Fig. 25
 Prototipo della Prima

Tavoletta 3D RGB,
canale RED, rosso,
Tavoletta senza errori di
stampa in RESINA, solo
Cavaliere (prova di
stampa).
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Per ulteriori sperimentazioni e riflessioni riguardo la percezione tattile delle tavolette in 3D
ottenute seguendo questa metodologia e per eventuali migliorie e sviluppi della presente
Ricerca, si rimanda ad una sessione in cui sarà molto utile raccogliere impressioni e
testimonianze da parte di soggetti non vedenti. Dopo aver sottoposto ad essi le tre tavolette,
rappresentanti ciascuna un canale RGB, si chiederà loro di “toccare con mano” le differenze di
colorazione che sono percepibili alla vista, attivando così una corrispondenza tra i due sensi.
Effettuare poi la stessa esperienza anche con soggetti vedenti all’interno di una stanza immersa
nell’oscurità, proponendo una sorta di “cena al buio”, rappresenterebbe un’ulteriore
opportunità per i fruitori. Verrebbe offerta infatti una differente interazione con l’opera d’arte
che potrebbe far emergere dettagli non altrimenti percepibili e permetterebbe anche di
confrontare le differenti percezioni di soggetti vedenti e non nei confronti dell’opera stessa.

 

 

 

 

NOTE

1 Progetto CaRoGuiMus9, Parte 1, Studi sulla percezione del colore, Prima Ricerca, Tavolette pseudo-braille
cromatiche http://www.bta.it/riv/rice/caroguimus9/index.html consultato in data 22/01/2018.

2 Stefano Colonna, richiesta formulata in data 27/11/2018 e conseguente risposta di Andrea Chiariello del
28/11/2018, gruppo Facebook di Architettura Liquida.

 Si veda: https://www.facebook.com/groups/architetturaliquida/permalink/938190169645048/ 
 
[Stefano Colonna, 27/11/2018]:

 «[ricerca software open linux] carissimi/e sto cercando un software open source che possa girare in ambiente
GNU/Linux meglio ancora Debian che sia in grado di mappare i valori RGB (red, green, blu) di una foto
digitalizzata praticamente un file tiff o jpg creando un istogramma tridimensionale ed esportandone i valori
numerici in formato vettoriale. Il file vettoriale esportato dovrebbe essere codificato secondo uno standard
universalmente riconosciuto in modo da poter essere processato con un altro software per altri scopi. Perdonate
eventuale crossposting. Grazie» 

  
[Andrea Chiariello, 28/11/2018]:

 «Cari amici, questa la proposta con Octave:»
 __________________________________________

 % carico l'immagine da elaborare
 % I è una matrice Nx,Ny,3 nelle 3 dimensioni c'è la codifica R G B dell'immagine

  
I=imread('Renoirlow.jpg');

 % la mostro a video
 imshow(I)

  
% metto degli zeri nelle colonne 2 e 3, quindi sto togliendo il verde e il blu

 % in Ired c'è solo il contenuto Red dell'immagine
 Ired=I; Ired(:,:,2:3)=0;

 imshow(Ired)
  

% metto degli zeri nelle colonne 1 e 3, quindi sto togliendo il rosso e il blu
 % in Igreen c'è solo il contenuto Red dell'immagine

  
Igreen=I; Igreen(:,:,1)=0; Igreen(:,:,3)=0;

 imshow(Igreen)
  

% metto degli zeri nelle colonne 1 e 2, quindi sto togliendo il rosso e il verde
 % in Iblu c'è solo il contenuto Red dell'immagine

  
Iblu=I; Iblu(:,:,1:2)=0;

 imshow(Iblu)

3 Software libero distribuito sotto licenza GPL (General Public License). Per maggiori informazioni si rimanda al
link: https://www.gnu.org/software/octave/ consultato in data 10/03/2018.

4 Codice GNU Octave fornito da Andrea CHIARIELLO in data 28/11/2016 e così modificato da Stefano
COLONNA:

  
% carico l'immagine da elaborare

 % I è una matrice Nx,Ny,3 nelle 3 dimensioni c'è la codifica R G B dell'immagine
  

Fig. 26
 Prototipo della Prima

Tavoletta 3D RGB,
canale RED, rosso,
DETTAGLIO Tavoletta
senza errori di stampa
in RESINA, solo
Cavaliere (prova di
stampa).

Fig. 27
 Prototipo della Prima

Tavoletta 3D RGB,
canale RED, rosso,
Tavoletta senza errori di
stampa in RESINA,
Tavoletta intera.

Fig. 28
 Prototipo della Prima

Tavoletta 3D RGB,
canale RED, rosso,
Tavoletta senza errori di
stampa in RESINA,
Tavoletta intera,
dettaglio Alberello e
Figura femminile di
destra.

Fig. 29
 Prototipo della Prima

Tavoletta 3D RGB,
canale RED, rosso,
Tavoletta senza errori di
stampa in RESINA,
Tavoletta intera,
dettaglio Figura
femminile di sinistra.
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I=imread('/home/stecolumna/Immagini/Octave/immagini_prova/RAFFA-8bit.jpg');
 % la mostro a video

 imshow(I)
  

% metto degli zeri nelle colonne 2 e 3, quindi sto togliendo il verde e il blu
 % in Ired c'è solo il contenuto Red dell'immagine

 Ired=I; Ired(:,:,2:3)=0;
 imshow(Ired)

  
% metto degli zeri nelle colonne 1 e 3, quindi sto togliendo il rosso e il blu

 % in Igreen c'è solo il contenuto Red dell'immagine
  

Igreen=I; Igreen(:,:,1)=0; Igreen(:,:,3)=0;
 imshow(Igreen)

  
% metto degli zeri nelle colonne 1 e 2, quindi sto togliendo il rosso e il verde

 % in Iblu c'è solo il contenuto Red dell'immagine
  

Iblu=I; Iblu(:,:,1:2)=0;
 imshow(Iblu)

5 Cfr.: http://www.bta.it/img/a2/28/bta02892.jpg consultato in data 25/01/2018.

6 Cfr.: https://helpx.adobe.com/it/photoshop/using/channel-basics.html consultato in data 03/02/2018.

7 Per ulteriori chiarimenti si rimanda al link: https://www.photoshopessentials.com/essentials/16-bit/ consultato in
data 03/02/2018.
8 Guglielmo M. G. Chiavistelli, La scultura digitale, BTA - Bollettino Telematico dell'Arte, 22/07/2017, n. 843.

 Si veda: http://bta.it/txt/a0/08/bta00843.html consultato in data 05/02/2018.

9 Mauro Minetti, Risoluzione e qualità dell’immagine digitale, Nikonschool.it
 https://www.nikonschool.it/experience/risoluzione3.php consultato in data 05/02/2018.

10 Acronimo che sta per “Computer-Aided Design”, ovvero “Progettazione Assistita dall’Elaboratore”.

11 Per ulteriori chiarimenti si rimanda al link: https://www.pluralsight.com/blog/film-games/bump-normal-and-
displacement-maps consultato in data 14/02/2018.

12 Photoshop infatti riproduce milioni di colori, ma per farlo riconosce ed elabora soltanto canali grayscale.

13 Per ulteriori chiarimenti si rimanda al link: https://www.photoshopessentials.com/essentials/rgb/ consultato in
data 17/02/2018.

14 Il sito internet del portale 3DRilievi.it è consultabile al link: http://www.3drilievi.it/Forum/page/index.html

15 Canale YouTube di Roger Webb: https://www.youtube.com/channel/UCVbRweyeFzc6j7_VYQjwxYQ
consultato in data 20/12/2017.

16 All’acronimo CAD già spiegato in precedenza si aggiunge CAM: “Computer-Aided Manufacturing”, ovvero
“Produzione Assistita dall’Elaboratore”.

17 Autodesk University, ArtCAM - Software for Artists Rather Than Engineers, traduzione dell’autore.
https://knowledge.autodesk.com/support/artcam/learn-explore/caas/auonline/content/au/global/en/au-
online/classes-on-demand/class-catalog/classes/year-2015/artcam/mfg12193/jcr-content.html?v=2017 consultato
in data 20/02/2018.

18 Per ulteriori chiarimenti si rimanda al link: http://www.percorsitattili.com/linee_guida_03c.htm consultato in
data 24/02/2018.

19 Autodesk Help, ArtCAM: Ammorbidimento di un rilievo
 https://knowledge.autodesk.com/it/support/artcam/learn-explore/caas/CloudHelp/cloudhelp/2018/ITA/ARTC-

WhatsNew/files/GUID-8B175067-1E11-4BE8-BB6E-B29B77C3BC74-htm.html consultato in data 24/02/2018.

20 Noemalab, I difetti nella riproduzione dell’immagine http://org.noemalab.eu/sections/specials/tetcm/2002-
03/dvd/difetti.html consultato in data 22/02/2018.

21 Ibidem.

22 Ibidem.

23 Autodesk Help, Create Triangle Mesh, traduzione dell’autore
 https://knowledge.autodesk.com/support/artcam/learn-explore/caas/CloudHelp/cloudhelp/2018/ENU/ARTC-
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ReferenceHelp/files/GUID-8A642523-E3D1-4D3A-9D0D-1646BCFD6074-htm.html consultato in data
25/02/2018.

24 Per maggiori informazioni si rimanda al link: https://www.3ditaly.it/chi-siamo/ consultato in data 10/03/2018.

25 Ibidem.

26 Per maggiori sulla stampante ULTIMAKER 3 si rimanda al link:
https://www.3ditalyshop.it/prodotto/stampanti-3d/ultimaker/ultimaker-3/ consultato in data 10/03/2018.

27 L’eccezionale definizione di stampa raggiunta dalla stampante FORM 2 la rende uno strumento perfetto per le
aziende che operano nel design di gioielli, in campo biomedico, nell’ingegneria, nella robotica e nella meccanica,
piuttosto che nel modellismo e nell’animazione. Per maggiori informazioni si rimanda al link:
https://www.3ditalyshop.it/prodotto/stampanti-3d/formlabs/formlabs-form-2/ consultato in data 10/03/2018.
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3DiTALY
 3DiTALY, sito internet, sezione “Chi siamo” < https://www.3ditaly.it/chi-siamo/ >

 Scheda tecnica ULTIMAKER 3 https://www.3ditalyshop.it/prodotto/stampanti-3d/ultimaker/ultimaker-3/ 
 Scheda tecnica FORM 2 https://www.3ditalyshop.it/prodotto/stampanti-3d/formlabs/formlabs-form-2/

  
3DRilievi

 Homepage del portale http://www.3drilievi.it/Forum/page/index.html
  

ADOBE HELPX
 Adobe Helpx - Photoshop guida utente, Nozioni di base sui canali

 https://helpx.adobe.com/it/photoshop/using/channel-basics.html
  

AUTODESK KNOWLEDGE NETWORK
 Autodesk University, ArtCAM - Software for Artists Rather Than Engineers, traduzione dell’autore

 https://knowledge.autodesk.com/support/artcam/learn-explore/caas/auonline/content/au/global/en/au-
online/classes-on-demand/class-catalog/classes/year-2015/artcam/mfg12193/jcr-content.html?v=2017 

  
Autodesk Help, ArtCAM: Ammorbidimento di un rilievo

 https://knowledge.autodesk.com/it/support/artcam/learn-explore/caas/CloudHelp/cloudhelp/2018/ITA/ARTC-
WhatsNew/files/GUID-8B175067-1E11-4BE8-BB6E-B29B77C3BC74-htm.html

  
Autodesk Help, Create Triangle Mesh, traduzione dell’autore

 https://knowledge.autodesk.com/support/artcam/learn-explore/caas/CloudHelp/cloudhelp/2018/ENU/ARTC-
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BTA - BOLLETTINO TELEMATICO DELL’ARTE
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cromatiche http://www.bta.it/riv/rice/caroguimus9/index.html

  
Guglielmo M. G. Chiavistelli, La scultura digitale, BTA - Bollettino Telematico dell'Arte, 22.07.2017, n. 843
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GNU OCTAVE
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 https://www.gnu.org/software/octave/
  

NIKONSCHOOL
 Mauro Minetti, Risoluzione e qualità dell’immagine digitale, Nikonschool.it 

 https://www.nikonschool.it/experience/risoluzione3.php
  

NOEMALAB
 NoemaLab, I difetti nella riproduzione dell’immagine

 http://org.noemalab.eu/sections/specials/tetcm/2002-03/dvd/difetti.html
  

PHOTOSHOPESSENTIALS
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PLURALSIGHT

 Pluralsight, articolo del 14.08.2014
 https://www.pluralsight.com/blog/film-games/bump-normal-and-displacement-maps

  
YOUTUBE

 Canale personale di Roger Clyde Webb
 https://www.youtube.com/channel/UCVbRweyeFzc6j7_VYQjwxYQ

  

IMMAGINI

Tutte le immagini presenti in questo testo sono state appositamente create dall’autore con lo scopo di illustrare i
vari passaggi della metodologia applicata. Sono pertanto tutte originali ad eccezione delle seguenti, che comunque
sono state rielaborate a seconda delle necessità:

  
• Immagine di partenza del Sogno del Cavaliere di Raffaello Sanzio

 http://www.bta.it/img/a2/28/bta02892.jpg
  

• Fotografie digitali raffiguranti la Creazione di Adamo di Michelangelo Buonarroti
 https://it.wikipedia.org/wiki/File:Michelangelo_-_Creation_of_Adam.jpg 

 https://it.wikipedia.org/wiki/File:Michelangelo,_Creation_of_Adam_04.jpg
  

• Texture del muro di mattoni utilizzata per creare la mappa di rilievo esplicativa
 https://get.pxhere.com/photo/architecture-house-texture-floor-building-city-wall-construction-line-red-desktop-

tile-stone-wall-brick-material-stove-block-fortress-background-design-decorative-cement-scene-barrier-
brickwork-obstacle-element-plaster-solid-deadlock-flooring-road-surface-856288.jpg

  

SOFTWARE
Adobe Photoshop CC 2018

 Autodesk Maya 2018
 Autodesk ArtCAM Premium 2017

 MeshLab 64bit v2016.12
 Microsoft Word

 Adobe Acrobat
 

SISTEMI OPERATIVI
MacOS High Sierra v10.13.3

 Windows 7 Ultimate 64 bit
 

 

 

 

 

 

 

 

Contributo valutato da due referees anonimi nel rispetto delle finalità scientifiche, informative, creative e culturali
storico-artistiche della rivista
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